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Power point program is one of Microsoft's products, and is used to design electronic

presentations where electronic display consists of a set of slides and used as a means to illustrate

the idea of clarifying certain to be shown in the auditorium of the number of attendees. Where is

prepared slides containing the first and the slides on texts and images, sounds and graphics can

move text and images in the presentation.

Mode of operation of PowerPoint program: -

Start >> all program >> Microsoft Office >> Microsoft Oftice Power Point 2007

Then begins to work PowerPoint program.

QOutline of the screen: -

When you run the program window appears PowerPoint as specified in the following figure
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Part notes

Note in PowerPoint 2007 changed signitficantly is the area the top of the PowerPoint. Instead of menus
and toolbars that I used to see them in PowerPoint 2003, there 1s a long bar appears at the top screen
contains many visible commands clearly and ranked in groups .called on this tape long "ribbon", which
1s now considered the control center, which will help you to create a display presentation. So do not be
a need to search for them in menus or toolbars are not displayed.
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Consists of "' tape " from the following tabs : -

e tab " Home " Home Here is all the commands displayed as buttons , it supports a variety of
tasks , including copy and paste , and add slides, change the slide layout , and format the text
and the appointment of his site , and search and replace text .

e tab "Insert " Insert Here 1s all you may need to put in the slide - from tables , pictures, diagrams
, charts and text boxes to the sounds and hyperlinks , headers and footers .

e tab " design " Design from which you can choose the form of incomplete segments includes
background design , fonts, and color scheme , and then customize this format.

e tab " movements " Animations Here is all animation effects . s the basic movements are easier
to add to the lists or charts .

e tab " slide show " Slide Show you can determine the color of a pen or a certain segment of the
start of it. You can also record narration , and review the offer quickly , and make some other
preparatory tasks .

e tab " Review " Review where you find the spell checker and research services . Mark team have
used annotations to review the presentation , and then see these comments .

e tab " View " View you can make a quick switch to a view " page notes ," and show grid lines ,
or organize all open presentations in the frame.

e It also shows the status bar at the bottom of the display screen displays PowerPoint us
information, such as the slide number and the name of the design template applied to the slide
that 1s displayed and the display buttons and a sliding zoom in / out to zoom view slide in or out
. Clicking buttons minus ( -) and plus ( ) as well as to perform the same thing .
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Displav Presentation: -

Microsoft PowerPoint by default called any new file is created on behalf of the presentation and the
first presentation will be named default ( Presentation 1) and its extension ppt which means that the full
name be ( presentation 1.ppt), the presentation may consist of a single chip or multiple slides , which in
turn may contain text, images, sounds and graphics can Post an sounds and kinetics for the texts ,
images and objects .and any presentation 1s created to be given the name of its own 1n order to be
practical conservation through it and in this way it becomes an electronic file stored in the computer's
memory so you can refer to it at any moment In order to open and view the contents or modify it .
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Slide:-

Constructivism 1s the unit that make up the presentation and can be placed where writings, pictures,
objects, backgrounds, kinetic etfects, sound effects and hyperlinks.

Slab slides (part slides)
Yemen, which 1s part of the program window as in the following figure contains part of the slide on

the top (Outline tab) and (tab slides); where you can switch between them by clicking on the right-ease
tab.

Tab QOutline

Slides tab

Close slab
slides

Qutline tab

i g

It represents the outline text slide - slide where
the text appears in outline form for each shide in
the presentation, as in the current format, which is
the best place to start writing content, and Post an
amendment, delete, and move slides and text as
desired.
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Tab slides

To move to this tab to see the slides in e f",-nf:f_l ‘; |%lsfﬁf7‘f Al ST
the presentation miniature-sized pictures | —
during editing. Thumbnail facilitate |
mobility in the presentation and see the N e
effects of design changes. You can also

: i ' i i
rearrange the slides, add, or delete them. o ‘ | |
As shown in the figure. | s
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Buttons Display

Are the buttons on the bottom of the screen the program from the left side in the status bar by clicking
Right-ease on the display button where you can through buttons display to determine how the slide
show and the buttons represent three main ways to view slides and each view has a certain style,
namely: -

e normal view
e Slide Sorter View
e slideshow

Slideshow Slide Sorter View Normal view

!

}
| = | 55 13 y|

And you can access them in a manner and within seconds "View" tab, click the Group "offers ways to
display your presentation,” and then choose the right offer, as in the following figure.
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Buttons Display
=

_INormal view
The default display is to create and modify slides in PowerPoint contains most of the tools you need to
write the user and the presentation and design. To display the work of three aspects: to the right part of
the slide, and to the left task pane; In the bottom part notes.

B
Slide Sorter View

Slide Sorter View is a special offer for slides in the form of thumbnails, when you have finished
creating your presentation, edit, Slide Sorter gives an overall picture of him making it easier to

rearrange the slides, or added, or deleted, and preview the effects of the transition and animation
effects.

=1

J
~= Showing "slideshow"
Is a slide show to fill the computer screen, are viewed full-screen presentation, as will be seen
attendance. Where you can see how the image will look like, and timing, and movies, and animated
elements, and transition effects in the actual display.
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Part observations: -

The lower partisin normal view and show the phrase (click to add notes) where you write your feedback that
vou watit to accompany a slide. Y ou can print these notes as pages of notes displayed when vou save a
presentation as a Web page. Where Y ou can add notes on the content of each slide, by clicking the right-ease
in the part of the notes as shown in the figure bel ow, and the page 15 displayed notes of "View" tab and in the
group of "methods of display presentations." and then notes page where Post an editing notes,
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liclt here to add

Dealing with slide :-

o data entry
To enter data into the slide click inside the rectangle appropriate, "Click to add title" and then type the
text you Trgh.nag on the slide always resides within a place called the deputy a text box (text bax) or
be a form of automatic (Auto shape),

o insert a new slide insert New Slide

To insert a new blank slide, select the slide you want to insert a slide and then do one of the following
actions:

o the tab "Home Home" click the "slices Slides", click the new slide |, as in the following figure.
7
Home Insert Design Animatians
== | =] Layout ~
J (5| Reset
Paste Mew B
- be siide ~ % Delete

Clipboar ‘ lide
o Right-click on the current slide ¥ emen menu appears and chooge a new chip as in the following

figure
o of the keyboard, click on the ctrl key with the key +14
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e Delete Slide

To delete the slice , select the slide you want to delete and do one of the following : -

the Home tab , click the segments , click Delete .

Right-click on the current slide Yemen menu appears and choose Delete slice
Click on the DELETE key or Backspace on your keyboard to delete the slide.
Copy, Cut ( transfer ) , paste slide (copy, cut, paste slide)

Select the slide you want to copy and do one of the following actions: - = | Home | msert
Click Right-click the selected slide , and then click Copy to copy or =
From Home Tab in part clipboard to click Copy button =2 or button paste Pa;.]
e pressing CTRL+ C to copy and press CTRL+ X from the keyboard. v

Clipboard

e Paste Slide

After a Copy command or the Cut command segments, must use the Paste command and execute this
command, click the slide you want to be followed by slides copied or shredded and do one of the
following actions:

e Click Right-click the slide that you want to be followed by slides copied or shredded, and then
click Paste.

e From Home Tab in part clipboard, click the Paste button =

e pressing CTRL V from the keyboard.

!
0' Hint: - slide can be moved in a way that drag and select the slide, which you want to move and
click the left mouse button and drag it to a new position in the board or part of the slide, and look for a
horizontal line beneath the slide that you want to be followed, then release the mouse button.

e [ide Slide
Select the slide you want to hide and do one of the following actions:

e the tab "slide show" in the "preparation", click "Hide slide," as in the following figure

Animations Slide Show Review View

p _:j S b5 Record Narration @l Ri

X _fj'/ Rehearse Timings
Set Up Hide e
Slide Show Slide ¥ Use Rehearsed Timings Us
Set Up

e Click Right-click the slide you want to hide, and then hide the slice.
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Symbol appears hidden slide @ with the slide number inside, next to the slide that conceal. As in
the following figure.

The hidden slide

.
e
I \I 1

\ Hint: - keep the slide in the file, even though they be hidden while running the presentation.

= repeat slides
Select the slide that you want to replicate and do one of the following actions: -

e Press the keys (CTRL D) of the keyboard
e Click Right-click the slide that you want to replicate, and then slice duplicate as in the following figure

Duplicate slides are included directly in the bottom of the slide that you specify.

e 1
Hint: -

* To determine a single slice, click it.

* To select multiple consecutive slides, click the first slide and press SHIFT, and then click the last slice want
to be identified.

* To select multiple non-consecutive slides, press CTRL, and then click each slide you want to select
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=  Add a background to vour presentation
®  add attributes of the slide.

Note in Microsoft Office PowerPoint 2007, that features replace design templates ( design template
: A file contains the styles in a presentation , including the type and size of bullets and fonts, sizes
and placements placeholders , and design background, and the mobilization of color schemes ),
which was used in versions Previous . Can coordinate the entire presentation quickly and easily to
give the appearance of professional and talk him through the application of an attribute.

The feature is a set of formatting choices that include a set of ( theme colors and lines of the
attribute and the effects of the attribute ) .

The features contained within " tab design " in the group " attributes " . Where when you put the
cursor over a thumbnail image of the feature , you can preview how the pattem of the background
to the presentation. If you want to apply this style, you clicked. As in the following figure.

. N

In the Design tab, in the Themes group, click the More button ™ , offer more features, and you can
change the colors, lines or lines and the effects of packaging used. The application of these changes to
the presentation slides km in the following figure.

o J
Home Insert Design Animations Slide Show Review View
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» allocation patterns backdrop for the presentation
Patterns backgrounds are displayed in thumbnail images in the gallery

e ) Background Styles =
patterns backgrounds. When you put the cursor over a thumbnail image of 2

the background pattern, you can preview how the pattern of the background Sl
to the presentation. If you want to apply this style, you clicked. Background
e Click the slide or slides you want to add style to the background.

e the tab "design" in the group "background", click the arrow next to the patterns backgrounds.
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e W
_o.'l Tip: If you wish to hide background graphics click the check box to hide background
graphics chipset as in the figure above

Click Right-click the background style that you want, as in the following figure
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And then do one of the following:

To apply a style background on selected slides, click Apply to selected slides.
e To apply a style to the background on all the slides in the presentation, click Apply to All
Slides.

e (Coordination Background: -

You can work formats for background slide through
patterns backgrounds where you can color a schism

Post an article or use a photo as wallpaper or as in Fig.
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First: - Create a presentation using blank presentation: -

The first way: click the button Microsoft Office, click New, and
then click an empty talk and the bottom of the molds, and then
double

-Click down the offer of a blank and empty talk, or click on.
Also Created in shape.
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The second way - through the right-ease to click Jon the New button from the Quick Access Toolbar
as shown in Figure

(-0 w0-9d

Create a presentation using templates installed

Installed templates: - 1s a file that contains the styles in a presentation, including the type and size of
bullets, fonts, and background design, and color schemes to mobilize, where you can apply to a
presentation in order to provide the appearance of high-quality designer and fully. And you can. Apply
the template to all slides or on specific segments, and application templates, perform the following

steps: -

Click the button Microsoft Office, chck New, and then click New, and then click the bottom of the
mstalled templates Templates, and then double-click the one installed templates, or click on the
Created
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Slide layout: - identifies and defines the form of slide elements that can be contained in such slide, text
box, image, table, etc., as a program that provides a set of PowerPoint charts for each planning its own
use and you can apply a shde layout By following these steps: -

e Click Right-click the slide, and then click on the slide layout. Appears select the appropriate
planning layouts as in Figure below.
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Add the effects of mobility and audio to slides

In order to make the presentation more attractive and the impact on the public , who will deliver a presentation
to them you must add some of that kinetic effects and audio so that it does not feel bored audience . Effects that
can be added to the presentation : -

e slide transitions
e kinetic effects and audio

Add transitions between slides

Transitional phase is the kinetic effects that can be applied when the transition process between the chip and the
other like the transition from the first slide to the second tranche at this moment can make the second slide
appears on the screen from the bottom or top or in the form of diagonal or curtains or boxes etc. ... and you can
also control the speed of the transition effect for each slide , you can also add sound .

To add transitions between slides Perform the following procedure: -

On the " tab " movements , in the group "Move to this segment ," click the influence of slide transitions you
want to apply to this segment . To add the same transition to all slides in the presentation , click Apply to
a5 ste s il Al In the case of adding different stages of transition between slides in the presentation are
choosing the effect of slide transitions you want to apply to this segment.

Animations | Slide Show Review  View (7]

|

s Transition Sound: [Mo Sound]  ~ ||Advance Slide

]:o' I ﬂ‘ [ | v B Transition Speed: | Fast ~|| ¥ OnMouse Click

; iJﬂ.np\yTo All Automatically After: 00:00

a

Transition to This Slide

To appoint a speed slide transitions, in the group was transferred to this segment, click the arrow next to the
speed of transitions, and then select the desired speed. Speed of Tab shares click speed box and select an
appropriate speed .

(Slow, medium, fast).

v [crge W] JlEsV] Cowe
v fopw | TRJEEY 100l Acpw T
AT I SN Lol | Baakni 5,;.)]
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Add sound to slide transitions

Tab movements, the group was transferred to this evil PLATE, click the arrow next to the transfer of
voice, and then do one of the following

To add a sound from the list, select the sound you want.

To add a sound that does not exist in the list, select another voice, locate the sound you want to add,
then click OK.

First Class
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To add a voice to the other stages of the transitional segments, repeat steps.
Slideshow at a mouse click

Tab progress within the slice, select the check at a mouse click

Set the timing of the slideshow

Tab progress within the slice, select the check box automatically after then enter the number of
seconds you want the appearance of which slide on the screen.

A paall 0405
owslodl p8sll sue
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Can be applied to different stages of the transition between the slides and you can transition phase
itself to all the slides in the presentation by clicking on the "Apply to all slides”

Kinetic effects and audio -:

To add a visual effect or an audio special to text or an object where they can work influences
the kinetics of different objects inside the slide, or text, or graphics, charts, tables and other other
things can also add sounds and make these effects coincides with the movement of the object. For
example, you can make bullet points move to the inside of the right, each word individually, or hear
the sound of applause when you show a picture. To do so, do the following procedure.

= Trao | taliyes 13

First: - apply an effect on the movement of objects in the slide - _

as 3= gy u s ==

e Click the text or object you want to move it. | Uit | i

e tab "movement,” in the group "movements”, select the animation effect et 5y
that you want to move from the menu. As in Fig. o Aans asy> B

Second: - Create custom animation effect applied to text or object individually
e click the text or object that you want to want to move it.
e tab "movement." in the group "movements", click Custom Animation.

e appears in the Custom Animation task pane, click, Add Effect button and select the appropriate
influence from the menu as in the tigure below.

First Class
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To replace the effect of kinetic movement, text or other object impact,

follow these steps; -

Select the title you want to change the effect.

¥ ou will notice that the Add button sffect |7 255 :"’thlﬂ?zhnay change

Tgiraly button and then c¢lick the Change button [

J-‘.&"'S ﬁ:h;g

expand its own sub-menu, and choose New from the menu effect. Asin

the following figure,

Femove the effect of moving
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In the Custom Animation task pane, m the list of movements allocated, click the title which has the

o
effect of movement that vou want to remove Lo %o

Click.

A.dd voice to the movement

Must be've already added the impact of the
movement of the text or object before adding voice
e Click the slide that contains the animation
effect that vou want to add sound to it.
e tab movement, movement in the group,

click Custom Animation.

e the Custom Animation task pane, click the

F% s

Alosoio 1 olg_sgl_l_ |

JEA/RVERSWIR i |
Ll go saul]
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P | | e
PR |
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ajlil

amrow left of the animation effect in the Custom Ammation list, and then click anmmation ¢ffects.
s tab effect, within enhancements, click the arrow m the menu sound, and then do one of the

following:

Te add a sound from the menu, click sound.
To add a sound file, click the voice of another, and then locate the audio file vou want to use.
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Save the presentation
Created after the presentation and writing inside has to be saved to keep him permanently and save the
file for the first time, you will be prompted to give a name for the file extension PowerPoint ppt

format "2 and to make the save, follow one of the following steps: -

=

e Office of the menu button, click Save ===
e toolbar quick access click on the Save button
In both cases, a dialog box appears in which special conservation: -
Type the file name
Select a place to save the file
Click the Save button

PowerPoint file is saved in the form of display is ready

You can in PowerPoint to save the file , which 1s an - o el
extension ppt file format slide show is ready and who is T e omamests e
extending pps power point show)) of the advantages of =l

this type of file that 1s ready for viewing as soon as Lol

double-clicking on the file icon it does not open the
program PowerPoint , but it is running presentation and
start a slide show directed became like an executable file -
and be as

To make the save , follow these steps : -

Office of the menu button , click Save as
A dialog box will appear on behalf of special
conservation as in the following figure

From the dialog box
e Type the name of the file when the file name option.
e Seclect where to save the file when the option of saving in.
e Sclect the type of conservation and be the "power point show" at the option of the Save as type.
o Click the Save button.
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Set the direction of the slide
Diesign tab, in the Page Setup group, click the arrow next to the direction of the slide has been

identified trend slide horizontal or vertical.

o
el

T

Printing : -
Y ou can print the entire presentation of the segments, and the outline, and notes pages, and audience
handouts using colors, or gravscale, or black and white only. You can also print the slides, or bulletins,

or notes pages, or pages outline speocific.

Fllal . 4 3 ;
s Click the button Microsoft Office™ |, and click the arrow next to Print, and then click Print

Previewr.
PO I
_ 1F
Gosliall
[ el ] sy Microsoft XPS Document Writer [=] pC |
e | Microsoft XPS Document Writer : ﬂé:j:
XPSPort: tESacdl
walo el Aclats [T] iy ity
e . e Print each slide
PEeanll sac e a et Badlzell Bveny el OO0 fu Ll
a F S S
Determine 1= e Hs L €
the numb er of e IF—os¥e Szo . amfla il cAS R il ol adall olds] Jis-al od Add alframe around
copies — — et e each slice of printed
[T | || 1 T | Rl e TH | P Iz' Fat - L]
% Leagos Lasl & =) I__| toSsboal s parfagin
Bt e 2 Choose the type of
Sl rletles A Ast material you want

to print

stz || e ]
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Run the slide show: - il s (SRS e T S g e e

. , gy ; \ = % = —
First: t(_) start the slide show trom within Microsoft S Jaeans KD ("_J ] :—:- P )
PowerPoint i F — = — i
El)pen the presentation that you want to view it as a slide | s sw v ““:Ll g }:ISI "-",'::& ol b Sl
show.

Azl gl o3C el

Perform one of the following: -

e Click the slideshow bottom ® left of the window PowerPoint.
e tab "slide show" in the group "Start Slideshow", click "from the beginning” or "from the current

shide”
e press I'5.
Termination of the presentation: -
You can at any time terminate Presentation without waiting for the arrival of the last slice. To end the
offer at any time, follow one of the methods The following -:

1. press the Esc key on the keyboard.

2. Right-click on the slide during the presentation and select "Exit Offer” from the shortcut menu.
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